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Chapter 1  
Introduction 

Overview 
This guide is intended as a manual for upgrading earlier versions of the Agile e-series products to 
Agile e6.0.4 with the Agile Upgrade Tool.  

The Upgrade Tool allows a direct upgrade to Agile e6.0.4 from one of the following product 
versions: 

 CADIM/EDB 2.3.2 or higher 

 axalant 2000 SPx 

 Eigner PLM 5.x 

 Agile e6.x 

Prerequisites 
 Do not use the software in any situation where significant damage to property or 

business could occur from a software error. In no event will AGILE or any other 
party, who has been involved in the creation, production, or delivery of the software, 
be liable for special, direct, indirect, incidental, punitive, or consequential damages, 
including loss of profits, revenue, business, goodwill, data or computer programs, or 
inability to use the software, however, caused and regardless of the theory of liability 
even if AGILE or such other party has been advised of the possibility of such damages. 

 The Upgrade Tool addresses experienced project engineers and PLM administrators 
with customizing and database experience. Do not use the tool without the necessary 
knowledge. Read the complete manual in order to get all necessary information. 

 Do not attach to, or even change the production system. Always work on a copy of 
the production database dump. Avoid working on production computers to exclude 
any influence on the system. Never insert database connections of production 
database users in any configuration file or script except for exporting the dump or a 
source for copying tables (Production Database). 

 You should always be able to restart the old PLM version (CADIM/EDB, axalant or 
Eigner PLM 5.x) as a fallback strategy. 

 The best performance is reached when installing the Upgrade Tool on your database 
server. It is also possible to work on any machine in the LAN. 

 Dump upgrade takes up to 8 hours runtime per each environment - please have 
patience. 

 Upgrade Tool is running on Windows 2003 Server and all UNIX platforms officially 
supported for Agile e6-series. 

 At least JRE 1.4.2_08 should be installed on the machine and configured in the 
environment (JAVA_HOME must be set – this can be done in upg_env.cmd resp. 
upg_env.sh script). 

 SQLCMD.EXE should be installed. 
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 Database versions supported in this Upgrade Tool are Oracle 10.1.0.4 / Oracle 
10.2.0.2 and Microsoft SQL Server 2005 SP2 (English/German). 

 For production database link (step Takeover production data) Oracle 8.1.7 / 9.2.0.4 
and Microsoft SQL Server 2000 SP4 can be used. 

 ORACLE_HOME variable must be set for “system V” operating system – Unix/Linux 
etc. This can be done in script upg_env.cmd (upg_env.sh). 

 SQL*PLUS must be installed on the machine. 

 At least 250 MB hard disk space must be available for the software and generated log 
and data files on the local hard disk where the tool is installed. 

 At least 512 MB free RAM must be available to run a dump upgrade. 

 Sufficient disc space must be available to store copies of your production database 
and reference dumps on the machine / within the database. 

For additional information and most up-to-date upgrade information check the Agile Support 
page at http://eignersupport.agilesoft.com/index.asp (you will need a password to enter the 
support website). 

How it Works 
The Upgrade Tool is implemented in Java. The tool accesses the databases directly using a JDBC 
connection. The configuration of all upgrade steps is stored in a set of xml control files. In 
addition SQL scripts are used for special steps. 

 

The upgrade process is organized in following phases: 

 Pre-actions on the original production environment 

 Customizing Upgrade 
In this step the customization and configuration stored in the database is updated to 
Agile e6. The minimum passing time will be 4-5 hours (depending on the system. 
Main parameter is memory!). Make a copy of your production database dump. Do 
not attach your production system. Always work on a copy of your data. 

 Customizing / Test phase  
The Upgrade Tool will create a dump on which you can run Agile e6. All 
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functionalities must be tested to run correctly, including the whole customer-specific 
functionality. This dump is not error free. You have to check all functionalities and 
clear out the errors caused by setting up the Upgrade Tool. 

 Take over production data 
All tables containing production data, like document and item master data, are copied 
from the production system to your new Agile e6 dump. They will be adapted so that 
you can work on this data within Agile e6. 

Log files are created and stored in the log/ directory. After the dump upgrade is done, these files 
have to be reviewed, especially the errors.log file, to make sure there are no errors, otherwise, 
manual dump changes have to be made. Further “synchronize step” log files placed in data/sync 
have to be reviewed. Please control log files after each upgrade step and correct occurred errors 
manually before proceeding with upgrade. 
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Chapter 2  
Installation and Configuration 

ApplicationParameter.xml Template 
The Upgrade Ttool is preconfigured for an upgrade of an Oracle database dump. Before 
proceeding with upgrade on Microsoft SQL Server, please copy the file 
conf/template/ApplicationParameter.xml to conf/ApplicationParameter.xml. 

Database Settings in Oracle 
The Upgrade Tool needs a well configured database to provide a good performance. The Oracle 
standard database settings are not sufficient to run the program within the stated time. 

Oracle Parameters 
Check the Oracle parameters and verify that at least the following minimum values are set in your 
database instance: 

 db_cache_size >= 200,000,000 (200MB) 

 shared_pool_size >= 100,000,000 (100MB) 

 log_buffer >= 163,840 (3*64 Kbytes) 

If the database memory consumption is too small, adapt the values. 

If you use the server parameter file spfile (like in the Agile e6 standard installation), execute the 
following commands to change the values of the initialization parameters.  

 Login into Sql*Plus as user sys 

C:\> Sqlplus /nolog 
SQL>CONNECT <sys>@<db_service> as sysdba 
SQL>ALTER SYSTEM SET <parameter name>=<Value>  SCOPE=BOTH 

Note: Do not change the values of production systems. Make a copy of the 
initialization file and adapt the values.  

 Also read the Oracle online manuals and the Oracle10.1 installation manual from 
Agile.  

Oracle needs physical memory. If the system starts swapping or paging, the Oracle performance 
degrades or causes errors. Examine your free physical memory and prevent the OS from 
swapping. 

Some Unix systems have maximum values for shared memory. Refer to the installation 
instructions before changing any value.  

SQL Net Configuration. 
The network domain is part of different Oracle settings. Please check if the domain is consistently 
used for the following settings: 
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 Global Database 

 Service name 

 Listener.ora 

 Default domain name 

Global Database Name 

1. Login into Sql*Plus as user sys and check the global database name.  

The name should contain the network domain. Here is an example: 

sqlplus  <system>/<db_password>@<db_service> 
SQL>select * from global_name; 
GLOBAL_NAME ------------------------ 
PLM.WORLD 

The example uses the default network domain in world. Also possible are values like 
agile.agilesoft.com. 

2. Change the global database name login to Sql*Plus and execute the following commands: 

SQL>alter database global name plm.agile.agilesoft.com 

Service Name 
The service name in the SQL net configuration file tnsnames.ora in the directory 
$ORACLE_HOME/network/admin must include the network domain. 

1. Change to the directory $ORACLE_HOME/network/admin. 
2. Open the file tnsnames.ora and check if the service name is fully defined.  

That means the name contains the same network domain as the global database name. 

PLM.WORLD = 
  (DESCRIPTION = 
    (ADDRESS_LIST = 
      (ADDRESS = (PROTOCOL = TCP)(HOST = localhost)(PORT = 1521)) 
    ) 
    (CONNECT_DATA = 
      (SERVICE_NAME = PLM.WORLD) 
    ) 
  ) 

listener.ora 

1. Check if the global database name in the section SID_List of the listener configuration file 
contains also the same fully qualified global database name. 

SID_LIST_LISTENER_PLM = 
  (SID_LIST = 
    (SID_DESC = 
      (GLOBAL_DBNAME = PLM.WORLD) 
      (SID_NAME = plm) 
    ) 
  ) 
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LISTENER_PLM = 
  (DESCRIPTION = 
    (ADDRESS = (PROTOCOL = TCP)(HOST = localhost)(PORT = 1521)) 
  ) 

sqlnet.ora  
The default setting for the network domain in the sqlnet.ora file should be the same. Change to 
the directory $ORACLE_HOME/network/admin and open the file sqlnet.ora and check the 
default domain settings. 

names.default_domain = world 

Database Settings in Microsoft SQL Server 
The memory consumption of an SQL Server is dynamic. The actual memory settings on the new 
database server have to be controlled. 

1. Start the Enterprise Manager.  
2. In the Extra Menu select the server name and choose SQL-Server Properties.  
3. Select folder “memory” in the new window and adjust the values. 

Tablespaces / File Groups 
Check if the following table spaces (Oracle) or file groups (SQL Server) exist in your database.  

 edb_tmp  

 edb_tmpidx  

 edb_lob 

 edb_tmp 

 edb_tmpidx 

Note: If one of them does not exist, they have to be created! 

Oracle 

1. Change to the directory upgrade/ora/sql. 
2. Adapt file names, paths, and file size in the script cre_plm_tbs.sql. 
3. Login as user system to Sql*Plus and execute cre_axa_tbs.sql. 

sqlplus system/<password>@PLM60 
SQL> @cre_plm_tbs.sql 

SQL Server 

1. Check if the following file groups exist in your database: 

edb, edb_idx, edb_lob, edb_tmp, edb_tmpidx 

2. Call the script missing_f.cmd for the customer dump to create the missing file groups. 

Example how to call missing_f.cmd in the command line: 

missing_f.cmd1 sa2 password3 ceqell\axa4 edbprod5 d:\mssql\data6 d:\mssql\data7 d:\mssql\data8 
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Parameters: 

1 Script name to be executed 

2 Database administrator login 

3 Database administrator password 

4 Instance name (e.g. <hostname>\axa) 

5 Database name 

6 Path where edb_lob file group will be placed 

7 Path where edb_tmp file group will be placed  

8 Path where edb_tmpidx file group will be placed 

Pre-Activities on the Original Production Environment 
Since Eigner PLM 5.0 UIC <= 1000 and GIC <= 1000 are reserved for the standard development, 
existing users or groups using such C_IC / C_GIC must be migrated to a higher value. 

This action must be executed only on production dump with PLM version older than Eigner PLM 
5.0. This migration must be executed before you start any other upgrade activity. 

Note: It can be very time consuming!  

In a big customer dump it takes 1h/6 users. To solve the time conflict, break down the upgrade 
into different subsets and try to run it in parallel. 

To do this, adapt the following statement in the SQL script: 

INSERT INTO TEMP_U (OLD_U) SELECT C_IC FROM T_USER a 
WHERE 
C_IC > 200 AND C_IC < 1000 AND C_NAME NOT LIKE 'EDB%' AND  
C_NAME NOT LIKE 'DEMOEP%'; 

To execute the UIC/GIC Migration run following commands: 

sqlplus <user>/<password>@PLM 
SQL> @update_customers_UIC.sql 

On Microsoft SQL Server run following: 

cmd> sqlcmd.exe -x -S <server> -U <user> -P <password> 
-i ..\mssql\sql\update_customers_UIC.sql 
-o ..\log\update_customers_UIC.log 

Import Dumps 
Three dumps need to be imported into the new database environment: 

 Source reference dump 

 Target reference dump 
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 Customer dump 

For importing the dumps, do not change the table space names because the created table 
statements on tables containing a blob clause will fail if the original table spaces like EDB, 
EDB_IDX and EDB_LOB do not exist 

To import dumps into the database you have to be familiar with your database environment and 
Oracle / SQL Server import utilities as well. Alternatively, a batch script called imp_dmp.cmd can 
be used for automated imports (Oracle only). This script uses dumps located in the directory 
upgrade/dumps. 

Note: Because of a known Oracle 10g bug, an error ORA-01031 can occur during the 
import of a dump, or during the execution of SQL Script (it affects creation of 
indexes, especially in CRE_REP_EDB.SQL). Please check all upgrade files for 
this error. If this error number is found, please use the following workaround: 
Grant the corresponding user CREATE ANY INDEX right and restart the 
upgrade. This Bug is fixed in ONE-OFF patch 5924208 on Oracle 10.2.0.3. It 
might be fixed with Oracle 10.2.0.4. For more information please refer to 
Oracle bug # 5924208. 

Import Source Reference Dump 

1. Download appropriate source reference dump from 
http://eignersupport.agilesoft.com/index.asp and import it into the new database 
environment.  

Example: import plm50upgref.dmp into a user named PLM50UPGREF 

2. Import target reference dump. 
3. Download the latest target reference dump from http://eignersupport.agilesoft.com/index.asp 

and import it into the new database environment.  

Example: import plm601upgref.dmp into a user named PLM601UPGREF. 

Note: Agile Upgrade Tool supports the latest Agile e-series version only! 

Import Customer Dump 

1. Export the current production environment into a dump file and import it in the new 
environment.  

Note: Always work on this customer dump. Do not attach production dump during 
the upgrade process except for takeover step described below. 

This dump will be the new production dump after the upgrade is completed.  

2. Give the new environment an expressive name. 

Note: Change the database owner and (re-)create login/password account for each 
restored SQL Server database with the command file 
upgrade/cmd/chown_mssql.cmd delivered with Upgrade Tool. Run 
chown_mssql.cmd and provide the following information into the shell screen: 

 server: [localhost] - name of the SQL Server 

 server: [localhost] - name of the SQL Server 

 database name: [plm60] - name of the database 
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 new password:  - password for the new account 

 DB administrator: [sa] – database administrator 

 password: – administrator’s password 

 old schema name: – schema name, where objects are currently stored ('plm' for e6 
SQL Server databases). In most cases it is a schema, which owns the most objects 

Note: On SQL server set recovery model to “simple” for customer database, which 
prevents an unlimited growth of database log files. Run following statement to 
set the recovery model: 

ALTER DATABASE <database> SET RECOVERY SIMPLE WITH NO_WAIT 
GO 
ALTER DATABASE <database> set READ_COMMITTED_SNAPSHOT OFF 
GO 

Create Statistics for all Involved Database Schemas 

1. Check language settings. 

Because of an Oracle bug the setting for the environment variable NLS_LANG must be 
AMERICAN_AMERICA.WE8ISO8859P15. Otherwise, statistics will not be computed 
correctly. 

2. Login in Sql*Plus as user sys with sysdba privilege and perform analyzing. 

SQL> EXECUTE DBMS_STATS.GATHER_SCHEMA_STATS(<DBUSER>,CASCADE =>true); 

Run Upgrade Tool 
1. Set a DISPLAY variable on UNIX. 
2. Control the NLS_LANG setting in upg_env.sh (upg_env.cmd on windows) which specifies 

the client character set. “AMERICAN_AMERICA.WE8ISO8859P15” is a default setting for 
upgrade reference dumps. 

3. Adapt the following environment definitions in upg_env.sh on UNIX: 

 JAVA_HOME - at least JRE 1.4.2 is required by the Upgrade Tool. In the standard 
configuration of the file the JRE of the Agile e6 installation is used for that. 

 ORACLE_HOME - make sure that Oracle 10.1.4 environment is set before 
proceeding with upgrade. To check the environment for UNIX, execute the following 
commands:  

user@host:~> env|grep ORA 

The output should look like this: 
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Configure the Upgrade Tool 

Configure New Database Environment Connections 

1. Run start_upg.cmd (start_upg.sh on UNIX) and enter the following information for dumps 
in your new database environment.  

Each database connection can be tested with a “TEST” button on an appropriate tab. 

Note: Press return after every change in a field. The color turns back from red to 
black. Otherwise the changes will be lost. 
 
Use file group names in Tablespace fields for Microsoft SQL Server. These are 
case sensitive; therefore, you have to use lower case. 
 
If you want to connect to a Microsoft SQL Server named instance, please 
specify a correct servername\instancename in the field “server” as well as the 
corresponding TCP port number. You can find the appropriate port 
configuration within the Configuration Manager. 
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Parameter Description 

Host Host name of database server. 

Port Port number of Oracle listener (default 1521 ) or SQL Server port number (default 
1433). 

SID Oracle_SID (uppercase) or database name for SQL Server (lowercase). 

User Database user name. 

Password  Password from database user. 

Connection String Service name which is used to run SQL*PLUS commands on the machine the 
Upgrade Tool is installed on. 

Use fully qualified name including the network domain, i.e. 
plm60.agile.agilesoft.com. 

Note: the service name cannot be tested in the current version of the Upgrade Tool. 

Adapt table space names for each database connection since they are used, e.g. for creation of new 
database objects or running SQL scripts: 

Table Default EDB*

Index Default EDB_IDX*

LOB Default EDB_LOB*
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Temporary table Default EDB_TMP* (edb on SQL Server until axalant 2000 SP3 ) 

Temporary index EDB_TMPIDX* (edb_idx on SQL Server until axalant 2000 Sp3) 

Note: Lower case for SQL Server, upper case for Oracle. 

Configure Production Dump Connection 

1. Enter a database connection for the current production dump.  

This connection will be used at the end of the upgrade process in the “Takeover” phase. The 
definition of this connection is different, because it is implemented as a database link, which is 
temporary created in your new customer dump. Creation of the database link can be tested 
with the “TEST” button. 

This connection will not be used until the takeover phase of the upgrade process. 

Note: Press return after every change in a field. The color turns back from red to 
black. Otherwise, the changes will be lost. 
 
A named instance can also be used for a production environment connection. 
Please enter “servername\instancename” in the Server field in this case. 
 
For testing this connection, grant access to the current production 
environment for the customer database user running these statements as 
Microsoft SQL Server Administrator like SA. 
<login_name> is the customer database login. 

GRANT ALTER ANY LOGIN TO <login_name> 
GO 
GRANT ALTER ANY LINKED SERVER TO <login_name> 
GO 
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Parameter Description 

Service Name Oracle service name including network domain, i.e. AGILE.AGILESOFT.COM. 

Service name must be defined in tnsnames.ora. 

SID Oracle_SID (uppercase) or database name for SQL Server (lowercase). 

User Database user name. 

Password  Password of database user. 

Setting Upgrade Tool Parameters 
Review and correct the entries if necessary and check the following table for valid entries. The 
correct values can be determined with the Compute button. Always check the computed values. 

Note: Press return after every change in a field. The color turns back from red to 
black. Otherwise, the changes will be lost. 
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PLM-Version The customer dump version (before Agile e6 upgrade process). Following values are 

valid: 

01 = CADIB/EDB 2.3.x 
02 = AXALANT SP1 
03 = AXALANT SP2 
04 = AXALANT SP3 
05 = PLM 5.0 
06 = e6.0 LA 
07 = e6.0 GA 
08 = e6.0.1 
09 = e6.0.2 
10 = e6.0.3 

LogiView 
Timestamp 

All LogiView items with a change date after this time point will be deleted. You can 
adapt this value manually. Following values are possible: 

CADIM/EDB 2.3.2 – 19990329094555 
CADIM/EDB 2.3#3 – 19990707174038 
CADIM/EDB 2.3#4 – 19990707174038 
CADIM/EDB 2.3#5 – 20000329161725 
axalant2000 SP1 – 20001109140557 
axalant2000 SP2 – 20010723102350 
axalant2000 SP3 – 20011113092600 
axa2000 SP3 PA1 – 20020808110309 
Eigner PLM 5.0.1 - 20020830153411 
Agile e6.0 LA - 20050414160530 
Agile e6.0 GA - 20050615170000 
Agile e6.0.1 - 20051111135800 
Agile e6.0.2 - 20060630200000 
Agile e6.0.3 - 20070213080000 
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Classification –
Control file 

A file name of the control file for the customer dump in the present case. Valid 
entries are: 

cla_ctl.xml 
cla_ctl_with_multi_lang.xml 
cla_ctl_with_multi_lang_repl.xml 
cla_ctl_with_repl.xml 

 
Database Language Language for the database dump. This influences the migration of the classification 

date.  
Values: German, English 
Default: German 

Level Status that is set during classification upgrade for records in the tables T_CLA_DAT 
(pool attributes), T_GROUP_DAT (classes) 

Replication server The valid name of the database server, in case of an implemented database 
replication to the environment, should be migrated. 

Save Configuration 

1. Save the current configuration by selecting File > Save parameter. 
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Chapter 3  
Perform the Upgrade 

Perform the Upgrade in Interactive Mode 
This chapter describes how the customizing upgrade is executed interactively. There are different 
steps available for selection on the ACTION tab, which should be executed in the respective order. 

 

Step 1: Run Pre-Action-Scripts 
The command script upg03_preaction_sql.cmd will be executed. This script executes a couple of 
SQL scripts (depending on the customer dump version). Log files created in this step in the 
upgrade/log directory have to be reviewed manually before proceeding with upgrade. 

A complete list of SQL / LOG files created in this step can be found in the Appendix. 

Step 2: DTV-Upgrade 
This step upgrades the DataView repository and is generally split into two steps: 

 Compares the data sets from the different dumps and stores the changes in an XML 
file for the three possible operations: delete, insert and update: 
dtv_del.xml, dtv_ins.xml, dtv_upd.xml 
The Upgrade Tool selects each row from the source and the target reference dumps, 
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compares the data sets from both dumps to identify the differences, and checks if the 
customer has modified these data. The upgrade action (Insert, Update, and Delete) is 
determined for each record and the information is stored in a set of XML files. The 
migration rules are listed in the Appendix. 

Note: This step takes about 10 min - 4 hours. 

 Performing operations. The Upgrade Tool reads the XML files created during the 
previous operation and performs the corresponding SQL-statements. This step takes 
about 15 - 40 min. During the performing, an error log file data/dtv/dtv_err.xml is 
created and should be checked for possible errors. 

Note: A dtv_customizing.log is created in the directory data/dtv/ also. It contains 
conflicts, which occurred during the DTV-upgrade. This log file must be 
reviewed. 

Check log files in the directory upgrade\data\dtv. If an error occurs, check the error description in 
upgrade\log\erorrdetails.log.  

Note: The Upgrade Tool is only able to compare tables with the same table structure. 
Therefore, the DataView tables in the reference dumps (edb234upgref …) 
have an Agile e6 structure. 

Note: For a better readability, it is possible to create HTML files from the XML log 
files (see Convert XML files to HTML). 

Step 3: Run Before-Sync-Scripts 
The command script upg07_sync_update.cmd / upg07_sync_update.sh is executed. This script 
executes a SQL script (depending on the customer dump version). Log files created in this step in 
the upgrade/log directory have to be reviewed manually before proceeding with the upgrade. 

A complete list of SQL / LOG files created in this step can be found in the Appendix. 

Step 4: Synchronize_Repository 
During this step the table definition in DataView within the customer dump is compared to the 
physical table structure in the database. SQL statements to create and alter database objects are 
generated and executed automatically. The adaptation of the physical data structure will consist of 
the following steps: 

 Analyze phase 
In this phase you can see which statements the program will perform. It creates also a 
control file named conf/special.xml for field values and special tasks. This step takes 
about 1-6 min. 

 Review and edit the control file conf/special.xml 

 Synchronize phase 
In this step the database structure is converted according to the new DataView 
repository. This step takes about 1 min – 4 h. 

The data and log files are placed in the data\sync directory. A detailed description of the errors can 
be found in log\errordetail.log. 
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Note: If the program terminates the process and releases the connection because of a 
server error, drop the special.xml file in conf/ directory and copy the 
preconfigured template from conf/template into the conf/ directory. Restart 
the process. 

Analyze 

In this step, a proposal special.xml file is written to the conf/ directory. 

Configure special.xml for Synchronizing Repository 

The delivery package contains a preconfigured special.xml, which defines standard settings for all 
expected cases. Very often the customer dump contains inconsistencies so that in the analyze 
mode the tool will add entries to the special.xml file. In this case you need to review and adapt 
following configuration subsets: 

Note: Do not change or delete the default settings. 

 Static default values for columns changed from null to not null. 
In the following example the column T_TRE_DAT.CUR_FLAG is set to ‘n’. 

<FieldDefault> 
    <FieldName>T_TRE_DAT.CUR_FLAG</FieldName> 
    <FieldType>S</FieldType> 
    <FieldSize>1</FieldSize> 
    <DefaultValue> 
        <Value>n</Value> 
    </DefaultValue> 
</FieldDefault> 

 Dynamic default values. 
The field values can be computed dynamically based on a Java function / SQL 
statement. Preconfigured functions are available to use the number server to set 
values. Here an example for an SQL statement and JAVA generated field default: 

<FieldDefault> 
    <FieldName>T_CTX_DAT.EDB_SEQ</FieldName> 
    <FieldType>I</FieldType> 
    <FieldSize>4</FieldSize> 
    <DefaultValue> 
        <Select> 
            DISTINCT (SELECT COUNT(*) FROM T_CTX_DAT T WHERE T.C_ID &lt;=  thisRec.C_ID)*10  
        </Select>  
        <Where>C_ID &gt; 0</Where> 
    </DefaultValue> 
</FieldDefault> 
 
<FieldDefault> 
    <FieldName>T_MASTER_DOC.EDB_ID</FieldName> 
    <FieldType>I</FieldType> 
    <FieldSize>10</FieldSize> 
    <DefaultValue> 
        <Function>GetNewEDBID(EDBEDBID)</Function> 
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    </DefaultValue> 
</FieldDefault> 

 Rename tables. 
If you have used DFM already, the following tables must be renamed (only for 
upgrade from CADIM to Agile 6). 

• T_EER_SIT 

• T_EER_SIT_STR 

• T_EER_SIT_MED 

<RenameTable> 
    <TableName>T_EER_SIT</TableName> 
    <NewTableName>T_DDM_SIT</NewTableName> 
</RenameTable> 
<RenameTable> 
    <TableName>T_EER_SIT_STR</TableName> 
    <NewTableName>T_DDM_SIT_STR</NewTableName> 
</RenameTable> 

 Move fields. 
This option allows moving a column of a table inclusive stored values to a new 
location. To move a field you have to specify: 

• Source field (<table_name>.<column_name>) 

• Target field (<table_name>.<column_name>)and 

• Path (join condition between old and new table) 

The following sample configuration files show 3 different possibilities to move field values to a 
new location. 

<!-- Example transfer from typetable to entitytable. --> 
<MoveField> 
 <SourceField>T_DOC_DRW.CRE_USER</SourceField>  
 <Path>T_DOC_DRW.C_ID_2</Path>  
 <Path>T_DOC_DAT.C_ID</Path>  
 <DestField>T_DOC_DAT.CAX_CRE_SYSTEM</DestField>  
</MoveField>  

<!-- Example transfer from entitytable to entitytable via releationtable. --> 
<MoveField> 
 <SourceField>T_MASTER_DAT.PART_ID</SourceField>  
 <Path>T_MASTER_DAT.C_ID</Path>  
 <Path>T_MASTER_DOC.C_ID_1</Path>  
 <Path>T_MASTER_DOC.C_ID_2</Path>  
 <Path>T_DOC_DAT.C_ID</Path>  
 <DestField>T_DOC_DAT.CAX_CRE_SYSTEM</DestField>  
</MoveField>  

<!-- Example transfer in table. --> 
<MoveField> 
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 <SourceField>T_MASTER_DAT.PART_ID</SourceField>  
 <DestField>T_MASTER_DAT.EDB_ICON</DestField>  
</MoveField>  

If you have a CAX interface already installed, please check if one of the columns used to store 
CAX specific information is defined as a document-type-table-column. These columns are now 
part of the standard data-model and included in the document master table T_DOC_DAT 
(migration from CADIM to Agile e6). 

An example configuration file special_move.xml containing definition of moved fields is stored in 
the template directory conf/template/ 

 Change data type of a field 
The Upgrade Tool allows changing the type definition of columns like integer to 
string. If the value of a column for all records is null then also incompatible data type 
changes can be executed (e.g. string to integer). Cutting a string field is only possible 
if no record contains a longer value. Please check max length of stored values directly 
within Sql*Plus. 
 
You have to replace “false” by “true” to confirm such critical changes. The type 
definition “oldType” comes from the database; “newType” is the DataView definition 
(stored in T_FIELD. C_FORMAT). 

<FieldChange>  
 <FieldName>T_DOC_DAT.FOO</FieldName>  
 <ConfirmChange oldType="S80.0" newType="S40.0">false</ConfirmChange>  
</FieldChange> 

Synchronize 

In this step, dump structures are adapted to DataView repository using the special.xml entries to 
fill NOT NULL fields. 

Step 5: Run After-Sync-Script 
The command script upg08_postactions is executed. This script executes a set of SQL scripts. 
Check the results in the log files named log/08_*.log. For a complete list of log files please refer to 
the Appendix. 

During this upgrade step a valid reference to T_STA_LUT is established with values in 
EDB_STA_REF for each entry in T_CHK_STA. Additionally, EDB_LEVEL within the table 
T_STA_LUT is filled. 

Note: The values of the table T_STA_LUT have to be reviewed after the customizing 
upgrade. 

Additionally, BVB_ARTIKEL clean up step is executed. For more information please refer to 0 
Cleanup BVB_ARTIKEL. 

Note: PLM5 and older favorites are migrated in this upgrade step as well. For more 
information please refer to 14.5 Favorites upgrade. 

Note: The favorite migration can be performed after the first takeover execution 
because it needs standard browser entries, which are inserted later within the 
step BRW-upgrade. 
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And finally, the T_PRC_DAT.EDB_PRO_REF column is filled during this upgrade step. For more 
information please refer to Chapter 4 Additional Information, Project References in Processes. 

Step 6: Run Before-Common-Scripts 
The command script upg09_common_get is executed. This script starts the SQL script to save and 
delete standard LogiView models. Check log files named log\09%.log 

Step 7: EDB-Upgrade (Configuration) 
During this step the content of the common Agile configuration tables are upgraded. The 
appropriate xml files are stored in data/edb/ directory. 

1. Click on the button "create files".  

XML files edb_ins.xml, edb_del.xml, and edb_upd.xml are created. They can be reviewed 
before performing these actions in the database dump. 

2. Click on the button "Perform delete, insert, update".  

XML files created in the previous step are read and executed. Errors that occur during these 
actions are stored in edb_err.xml – please control this file. 

Note: If an error occurs, check the error description in upgrade\log\erorrdetails.log.  

Step 8: BRW-Upgrade (Browser) 
During this step the content of the browser configuration tables is upgraded. The appropriate xml 
files are stored in the data/brw/ directory. 

1. Click on the button "create files".  

XML files brw_ins.xml, brw_del.xml, and brw_upd.xml are created. They can be reviewed 
before performing these actions in the database dump. 

2. Click on the button "Perform delete, insert, update".  

XML files created in the previous step are read and executed. Errors that occur during these 
actions are stored in brw_err.xml – please control this file. 

Note: If an error occurs, check the error description in upgrade\log\erorrdetails.log. 

Step 9: DODE-Upgrade (Print Studio) 
During this step the content of the Print Studio configuration tables will be upgraded. The 
appropriate xml files are stored in data/dode/ directory. 

1. Click on the button "create files".  

XML files dode_ins.xml, dode_del.xml, and dode_upd.xml are created. They can be reviewed 
before performing these actions in the database dump. 

2. Click on the button "Perform delete, insert, update".  

XML files created in the previous step are read and executed. Errors that occur during these 
actions are stored in dode_err.xml – please control this file. 

Note: If an error occurs, check the error description in upgrade\log\erorrdetails.log. 
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Step 10: LGV-Upgrade (LogiView) 
Several standard LogiView procedures are changed in every new Agile PLM software release. All 
LogiView logic models are deleted – if they are identical to new ones respectively saved if they 
were changed. Next, all new logical models are re-inserted. After the upgrade, all LogiView 
changes made by customer have to be done again. 

Additionally standard LogiView variables, constants, and system variables are upgraded in the 
usual manner. 

The appropriate xml files are stored in data/lgv/ directory. 

1. Click on the button "create files".  

XML files lgv_ins.xml, lgv_del.xml, and lgv_upd.xml are created. They can be reviewed before 
performing these actions on the database dump. 

2. Click on the button "Perform delete, insert, update".  

XML files created in the previous step are read and executed. Errors that occur during these 
actions are stored in lgv_err.xml – please control this file. 

Note: If an error occurs, check the error description in upgrade\log\erorrdetails.log. 

Step 11: WFL-Upgrade (Workflow) 
During this step the content of the workflow configuration tables is upgraded. The appropriate 
xml files are stored in the data/wfl/ directory. 

1. Click on the button "create files".  

XML files wfl_ins.xml, wfl_del.xml, and wfl_upd.xml are created. They can be reviewed 
before performing these actions on the database dump. 

2. Click on the button "Perform delete, insert, update".  

XML files created in the previous step are read and executed. Errors that occur during these 
actions will be stored in wfl_err.xml – please control this file. 

Note: If an error occurs, check the error description in upgrade\log\erorrdetails.log. 

Step 12: CHG-Upgrade (Change Management) 
During this step the content of the change management configuration tables is upgraded. The 
appropriate xml files are stored in the data/chg/ directory. 

1. Click on the button "create files".  

XML files chg_ins.xml, chg_del.xml, and chg_upd.xml are created. They can be reviewed 
before performing these actions on the database dump. 

2. Click on the button "Perform delete, insert, update".  

XML files created in the previous step are read and executed. Errors that occur during these 
actions are stored in chg_err.xml – please control this file. 

Note: If an error occurs, check the error description in upgrade\log\erorrdetails.log. 
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Step 13: GTM-Upgrade (Classification) 
During this step the content of the classification configuration tables is upgraded. The appropriate 
xml files are stored in the data/gtm/ directory. 

1. Click on the button "create files".  

XML files gtm_ins.xml, gtm_del.xml ,and gtm_upd.xml are created. They can be reviewed 
before performing these actions on the database dump. 

2. Click on the button "Perform delete,insert,update".  

XML files created in the previous step are read and executed. Errors that occur during these 
actions are stored in gtm_err.xml – please control this file. 

Note: If an error occurs, check the error description in upgrade\log\erorrdetails.log. 

Step 14: GDM-Upgrade (Office Suite) 
During this step the content of the Office Suite configuration tables is upgraded. The appropriate 
xml files are stored in the data/gdm/ directory. 

1. Click on the button "create files".  

XML files gdm_ins.xml, gdm_del.xml, and gdm_upd.xml are created. They can be reviewed 
before performing these actions on the database dump. 

2. Click on the button "Perform delete, insert, update".  

XML files created in the previous step are read and executed. Errors that occur during these 
actions are stored in gdm_err.xml – please control this file. 

Note: If an error occurs, check the error description in upgrade\log\erorrdetails.log. 

Step 15: RMT-Upgrade (Requirement Management Traceability) 
During this step the content of the RMT-module configuration tables is upgraded. The 
appropriate xml files are stored in the data/rmt/ directory. 

1. Click on the button "create files".  

XML files rmt_ins.xml, rmt_del.xml, and rmt_upd.xml are created. They can be reviewed 
before performing these actions on the database dump. 

2. Click on the button "Perform delete, insert, update".  

XML files created in the previous step are read and executed. Errors that occur during these 
actions are stored in rmt_err.xml – please control this file. 

Note: If an error occurs, check the error description in upgrade\log\erorrdetails.log. 

Step 16: Run After-Common-Scripts 
The command script upg10_common_update is executed. This script executes an SQL script to 
migrate non-standard browser entries to the new Agile e6 browser based on the new database 
tables having a prefix T_EXP_*. Check the results in the log files named log/10_*.log. For a 
complete list of log files please refer to the Appendix. 

This step can be skipped if you are migrating from Agile e6.0 or newer. 
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Step 17: Upgrading Classification (Optional) 
In Eigner PLM 5.0 a new concept – Attribute pool was introduced. This step converts attributes 
within the customer dump to this new concept. This step has to be skipped, if you are migrating 
from PLM5.x version or newer. 

1. Click on “Determine merge condition”.  

A special xml control file data/cla/cla_merge_ctl.xml is created. It describes how attributes are 
moved into a global attribute pool and contains so-called merge groups. All attributes 
mapped onto the same pool attribute are in the same merge group. Please review it and adapt 
if changes are necessary. This mapping file is used at the end of the takeover phase to migrate 
current production data to existing attribute pool 

2. Click on “Perform mapping”. 

This will build the attribute pool and performs the mapping to items, documents, etc. 

Note: Please check log files located in the data/cla/ directory. For more information 
please refer to Chapter 4 Classification. 

Step 18: Classification Attribute Inheritance 
Since Agile e6.0, a new attribute inheritance concept was introduced. Only for versions earlier 
than Agile e6.0: to convert existing class attributes this upgrade step has to be executed.  

Note: It is not necessary if you are migrating from Agile e6.0 or newer. 

Step 19: Special Replace 
This optional upgrade step allows a string replacement within table content.  

This configuration file conf/specialreplace.xml contains an example definition for migrating from 
CADIM 2.3.x of substrings, which should be replaced by another string. 

Example: Update the strings ‘T_EER_SIT’ with ‘T_DDM_SIT’ in LogiView procedures. 

<?xml version="1.0" encoding="UTF-8"?> 
<special> 
 <replace> 
  <table>LV_DT_PRC</table> 
  <field>MAIN</field> 
  <example>T_EER_SIT</example> 
  <replacewith>T_DDM_SIT</replacewith> 
     </replace>  
</special> 

Specific Dump Changes 
Recreate customer specific indexes, views, packages, procedures and triggers, database constraints 
like field defaults, etc. 

Perform Upgrade in Batch Mode 
After the upgrade is tested completely in the interactive mode, it can be used in batch mode. 
UNIX scripts for batch mode execution are available, too. These have the .sh extension (instead of 
.cmd for Windows). 
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Note: Batch mode is intended for experienced upgrade users. Many upgrade steps 
are compressed to a few batch scripts, so they possibly need to be adapted 
manually. 

To make a complete upgrade please re-import all dumps, control the settings by starting the script 
start_upg.cmd (start_upg.sh on UNIX). Execute shell scripts one by one. 

Note: There is a sample script named batch_upgrade.cmd (batch_upgrade.sh on 
UNIX), which can be used for a complete dump upgrade. All dumps have to 
be re-imported before doing the batch upgrade 

The batch mode can be used in the following manner: 

1. Perform an upgrade in interactive mode 
2. Re-import customer dump 
3. Start start_upg.cmd and control the configuration 
4. Clean the log directory by executing upg01_pre_cleanlog.cmd 
5. Run the following scripts: 

• upg03_preaction_sql.cmd 

• upg05_dtv_update.cmd 

• upg07_sync_update.cmd 

• upg08_postaction.cmd 

• upg10_common_update.cmd 

• upg11_cla.cmd 

6. Control log files 
7. Take over production data by executing upg13_prod1_takeover.cmd 
8. Run post-action scripts by executing upg14_prod2_rep_update.cmd. 

Alternatively, a whole upgrade process may be performed in the batch mode: 

1. Import customer dump 
2. Start start_upg.cmd and configure the Upgrade Tool. 
3. Run following scripts: 

• upg03_preaction_sql.cmd 

• upg04_dtv_get.cmd 

• upg05_dtv_update.cmd 

• upg06_sync_get.cmd 

4. Adapt special.xml 
5. Run following scripts: 

• upg07_sync_update.cmd 

• upg08_postaction.cmd 

• upg09_common_get.cmd 

• upg10_common_update.cmd 
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• upg11_cla.cmd 

6. Control log files 
7. Take over production data by executing upg13_prod1_takeover.cmd 
8. Run post-action scripts by executing upg14_prod2_rep_update.cmd 

Import DataView Repository with DTV.BLD 
Even though the DataView internal repository entries are handled by the Upgrade Tool, it is 
sometimes useful to import it from a DTV.BLD file. This is possible with the script imp_dtv.cmd / 
imp_dtv.sh. 

Some parameters respective to the current application server configuration have to be adapted in 
the script before proceeding with the import. 

Note: Since the dtv.bld file has to be located on the application server machine, and 
there is no dtv.bld file available in the standard installation, this script can be 
executed on this machine only. 

Convert XML Files to HTML 
You can convert XML files to HTML and view them with a browser. The batch file xml2html.bat 
creates HTML files for insert, update, and delete. This function is available on Windows platforms 
only. 

Execute xml2html.cmd with one of the following parameter values, which specify the HTML file 
to be created for modules: 

 All – HTML files for all modules are created 

 Module name - HTML files only for specified modules are created, possible values 
are: dtv edb brw dode lgv wfl chg gdm rmt gtm 

Note: You need memory for approximately six times the XML file size! 
The batch job will run several hours. The Java Runtime Environment allocates 
512MB of memory. You can adjust the memory allocation by editing the file 
Upgrade\cmd\upg_env.cmd 

Takeover Production Data 
The next step is to transfer reference data from the production system. This phase is necessary, 
because during the upgrade and customization of the new environment new reference data (all 
tables except customized tables) is available in the old production dump. 

Takeover phase is separated in several tasks: 

1. Generate a relevant table list using a database connection to current production dump. This 
database connection is used as source for the tables copied into the new environment. No 
changes are made in the production database. 

2. Edit the list of tables, which should be copied during the takeover step. 
3. Takeover: drop tables in the new dump and copy them from the current production dump. 
4. Takeover the latest number server values. 
5. Make the dump up-to-date again by executing the step “Synchronize_repository” and 

appropriate post-actions. 
6. Perform a test in the new environment. Test all functionalities, maybe during training of the 

user. If errors occur, remove them via customizing. Not everything might be done 

26 Upgrade Manual 



Chapter 3 Perform the Upgrade 

automatically. During the test period a lot of new data is created in the production system. 
Therefore, the last two steps can be repeated till the new environment is error-free. 

7. If testing does not raise any errors you can switch the production database to the new one. 
Takeover your data from the production system (and the files!) again and the new 
environment is your production system. Shut down your old system. 

Pre-Action on Microsoft SQL Server 
Grant access to the current production environment for the customer database user running these 
statements as Microsoft SQL Server Administrator (e.g. SA).  
<login_name> is the customer database login. 

GRANT ALTER ANY LOGIN TO <login_name> 
GO 
GRANT ALTER ANY LINKED SERVER TO <login_name> 
GO 

Define Reference Tables 
Select the folder Takeover in the Upgrade Tool and press the button Create Ref File. The Upgrade 
Tool will connect to the production database, identifies all tables and synchronizes the 
information with the predefined list (ref_tables.xml). Only tables with data are written to the file. 

Edit Production Table List 
To adapt the list, press Edit ref. File. For each table you have to define if it is a reference table. 
(ref_data = y.) Such reference tables will be dropped to the customer dump and copied from the 
production system using the connection to the production DB. 

Select OK to save the XML file (conf/ref_tables.xml). 
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Note: On SQL server set recovery model to “simple” for customer database, which 
prevents an unlimited growth of database log files. Run following statement to 
set the recovery model: 

ALTER DATABASE <database> SET RECOVERY SIMPLE WITH NO_WAIT 
GO 
ALTER DATABASE <database> set READ_COMMITTED_SNAPSHOT OFF 
GO 

Note: Because of a special BVB_ARTMEH upgrade functionality BVB_ARTIKEL, 
BVB_ARTMEH, and BVB_ARTMEHUFK tables have to be specified as 
production tables. Other BVB tables are treated as configuration tables. 
Otherwise, an error can occur during execution of SQL scripts artmeh_1.sql / 
artmeh_2.sql.  

Note: If you have created new users and / or groups since the date when the dump 
was exported form production system, the following DataView tables have to 
be migrated. Attention: new users like EDB-WFL, EDB-DFM, EDB-DDM, 
EDB-GDM, EDB-EER, DODEKERNEL will get lost. Export these users first 
with the binary loader and reload them after the upgrade. 

 T_USER 

 T_GROUP 

 T_GRP_USR 

 T_PROFILE 

 Related tables of the PLM – person management  

Note: Table T_DEFAULT should be migrated by the loader (import/overload) 
otherwise, new defaults will be missing. 

Perform Transfer 
Backup your customer Agile e6 dump and press the Takeover button. The tables containing non-
repository information are dropped in your customers dump. The tables will be copied from the 
defined production environment into your customer dump.  

Note: Check the log file log/errordetails.log 

Note: After copying production database tables, a special upgrade step will be 
automatically executed – Takeover Workflow Masks. This step is described 
later in this document. 

Taking Over Number Server Values 
Since the number server is used during the step “Synchronize_repository”, the newest values have 
to be transferred to the new environment. This is done by executing the step “AFTER 
TAKEOVER: takeover number server values”. Please control log files 14_01_get_numvalue.log 
and 14_02_set_numvalue.log. 

Post-Action Scripts 
Tables just copied from the current production environment have an old table structure and have 
to be upgraded. This is done with the following steps: 
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 Step “AFTER TAKEOVER: run before-sync-scripts” 
The command script upg07_sync_update.cmd will be executed. 
Check log files upg07%.log in the upgrade\log directory. 

 Step “AFTER TAKEOVER: Synchronize_repository” 
Execute “Synchronize” and control log/errors.log, control log files in data\sync. 

 Step “AFTER TAKEOVER > Run after-sync scripts” 
The command script upg15_prod3_postaction.cmd is executed. 
Check log files log/upg15%.log. The complete list of SQL scripts is described in the 
Appendix. 

Classification (Stage 2) 

Note: It is required that the attributes are already migrated and only the classification 
lists is updated. 

Click Perform mapping. 

Note: If the customer has created new classes and attributes in the production system 
after the customization, upgrade classes, attributes, and domain values have to 
be copied and migrated, too. 

Manual Dump Changes 

LogiView 

After the upgrade all LogiView changes made by customers in the standard have to be made again. 
The previous changed standard procedures can be found within the S<timestamp> LogiView 
models. 

STEP 

After the upgrade or productive takeover you have to check the defaults "EDB-STP-DEF-NO-
REF" and "EDB-STP-DEF-ORG-REF". During the upgrade to Agile e6 the values of these defaults 
were changed from "EP" to "NN". If the values of these defaults in your productive environment 
are already set "NN" (nothing needs to be done). 

These defaults are used as field defaults in several fields (<TABLE>.STEP_NO_REF, 
<TABLE>.STEP_ORG_REF). 

The Upgrade Tool provides default scripts (ora\sql\upg_org_ref_default.sql, 
ora\mssql\upg_org_ref_default.sql), which changes all values of these fields in the standard tables 
from "EP" to "NN". 

Please review the scripts according to your customizing. If you have not done any changes to your 
customizing regarding STEP_ORG_REF,STEP_NO_REF you can run the scripts without changes. 

If you do not run the script, it is possible to, e.g. duplicate PART_ID's in T_MASTER_DAT, 
because these two fields are used in the unique key constraint of T_MASTER_DAT. 

Customer Specific Changes 

Recreate customer specific views, packages, procedures and triggers, database constraints like field 
defaults, etc. 

Post-Actions on Microsoft SQL Server 
Before switching the production system to the new database, some changes have to be performed 
on the Microsoft SQL Server database. 
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Set recovery model and isolation level for customer database. These statements have to be 
executed from an administrative account - like SA. 

ALTER DATABASE <database> SET RECOVERY FULL WITH NO_WAIT 
GO 
ALTER DATABASE <database> set READ_COMMITTED_SNAPSHOT ON 
GO 

And finally, revoke access rights to old production database for the customer database user. These 
statements have to be executed from an administrative account – e.g. as user SA. 

<login_name> is the customer database login. 

REVOKE ALTER ANY LOGIN TO <login_name> 
GO 
REVOKE ALTER ANY LINKED SERVER TO <login_name> 
GO 
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Following special handling modules are integrated into the Upgrade Tool. Therefore, no 
additional actions are required to migrate the involved content. The steps described below are 
already integrated in the upgrade process and will be executed automatically. 

Browser Upgrade 
With Agile e6.0 release a new browser was introduced. It is based on new database tables having a 
prefix T_EXP_*. 

During the upgrade, standard content of these new tables is inserted. In addition, non-standard 
entries from the “old” browser are migrated. 

Cleanup BVB_ARTIKEL 
Some inconsistencies in the existing item data structure are eliminated during this specific 
upgrade step. Here a list of executed activities: 

 Redundant BVB_ARTIKEL entries are dropped. 

 All BVB_ARTIKEL records without corresponding T_MASTER_DAT entries are 
deleted. 

 Missing BVB_ARTIKEL records are inserted. 

 Missing values of T_MASTER_DAT.UNIT are inserted into BVB_MASSEH. 

STA_LUT 
For each entry in T_CHK_STA a valid reference to T_STA_LUT is established with values in 
T_CHK_STA.EDB_STA_REF. Additionally, EDB_LEVEL is filled within the table T_STA_LUT. 

Note: The values of the table T_STA_LUT have to be reviewed after the customizing 
upgrade. 

Project References in Processes 
There is a known problem within the projects workflow in Agile e6.0. In case of creating a relation 
between process and project, which has several versions, several entries are shown in the list 
because the PROJ_ID (kind of project name shortcut) is not unique over the stored versions. For 
this reason a new DB field is added: T_PRC_DAT.EDB_PRO_REF. 

If necessary, this field is filled with values during the upgrade step upg08_postaction. 
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BVB_ARTMEH Upgrade 
During this step, an upgrade of BVB_ARTMEH* tables is performed. SQL script artmeh_1.sql and 
artmeh_2.sql is executed within the upg08_postaction step. 

Favorites Upgrade 
The Upgrade Tool inserts several data into browser tables to make favorites and stored queries 
visible in the Agile e6 client browser window. 

Classification 
Overview attribute concept (old): 

 Attributes are defined class specific in the ATT concept. 

 Domain values for an attribute are defined in static menus. 

 No release procedures and status management for classes and attributes. 

Overview new pool concept: 

 Attributes can be defined class independent. 

 Pool attributes can be assigned to more than one class. 

 Domain values for a pool attribute can be stored in special domain tables. 

 For every class it can be specified which domain value is valid. 

The migration includes: 

 Merge attribute definitions. Attributes are considered as identical if the following 
values are identical: 

• C_LETTER  

• C_TITLE 

• C_TYPE 

If you have defined C-LETTER and C_TITLE as multi-lingual fields (standard since axalant 
2000), then you have to define with the Parameter “DB language” which language is used as 
standard for the merge. 

 Initial load of the attribute value pool including the activation of the attributes for 
special classes. 

 Update classification lists. 

 Update used field name. 

 Set of attribute ATT_VAL_REF in the classification lists. 

 Update field and mask definition (if you have defined own forms for classes). 
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Note: If possible, do not create or modify basic definitions of classes and attributes 
between customization upgrade and takeover data from production system. 
This influences the migration steps which must be executed after the takeover 
process. 

 No new classes and attributes are created. Only classification list tables have to be 
defined as reference table. 

• T_GRP_ART 

• T_GRP_DOC 

• T_GRP_ORD 

• T_GRP_PRO 

 Customers have created new classes and attributes in the production system after the 
customization upgrade. In addition to the classification list table classes, attributes, 
and domain values have to be copied and migrated. 

• T_GROUP_DAT 

• T_GROUP_STR 

• T_GRP_FLD 
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Workflow Takeover 
Since Upgrade Tool version 3.1.11 (upgrade to Agile e6.0.2) special generic workflow masks are 
copied during the takeover phase. 

After the takeover of the common tables, workflow masks are deleted, which are currently 
presented in the customer dump. Generic workflow masks are copied from the production 
database. Following tables are involved in this procedure: 

 T_MASK 

 T_MAS_FLD 

 T_FIELD 

 T_MENU 

 T_MEN_SEL 

Workflow masks have a special naming convention: EDB-WFL-<CID_OF_ACTIVITY> 

Entries within T_FIELD follow the naming rule EDB-DEC<CID_OF_ACTIVITY> 

 T_MEN_SEL entries contain names like EDB-SEL-<CID> and EDB-NSEL-<CID> 

 T_MENU entries of C_BUT_EDT / C_BUT_SEL / C_BUT_NOS are considered only 
for this action. 

During the takeover phase, all statements will be generated and executed within the Upgrade Tool 
and additionally written to full.log file.  
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Appendix A: CMD Scripts 
Here is a short description of all shell scripts included in the upgrade download package. 

Shell script Description Called SQL scripts 

chown_mssql.cmd (Re-) create a Login/User for an 
Microsoft SQL Server database 

- 

convert_it.cmd Convert XML data file for a single 
table to HTML files. This script is 
called from xml2html.cmd. 

-- 

exp_dmp.cmd This script helps you to export 
Oracle database to a dump file. 

-- 

imp_dmp.cmd This script helps you to create 
database users and import Oracle 
dump files. 

-- 

imp_dtv.cmd Imports the DataView repository. 
Please adapt parameters before 
running this script 

DEL_DTV.SQL > DEL_DTV.LOG 

missing_f.cmd Creates missing file groups in MS 
SQL Server. 

-- 

preaction_template.
cmd 

This file is for the upgrade (internal 
use only!). It is used as a template 
for creating the file preaction.cmd, 
which is needed if all upgrade steps 
are executed in batch mode. 

-- 

start_upg.cmd Starts upgrade user interface. -- 

upg01_pre_cleanlog
.cmd 

Cleans up all log files within the 
current upgrade project. 

-- 

upg03_preaction_sq
l.cmd 

Runs several SQL scripts depending 
on source, target and customer 
product versions. Called SQL scripts 
are saved in the file 
03_preaction_sql.log 

source: CRE_REP_EDB.SQL > 
03_01_CRE_REP_EDB.LOG 

source: TRUNC_LVTABS.SQL > 
03_TRUNC_LVTABS.LOG 

source: 
GRANT_SELECT_T_CONSTRAINT.SQL >  
03_16_GRANT_SELECT_T_CONSTRAINT.
LOG 

target: 
GRANT_SELECT_T_CONSTRAINT.SQL > 
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Shell script Description Called SQL scripts 

03_15_GRANT_SELECT_T_CONSTRAINT.
LOG 

CRE_REP_EDB.SQL > 
03_15_CRE_REP_EDB.LOG 

CLEANUP_C_ID_NULL.SQL > 
03_03_CLEANUP_C_ID_NULL.LOG 

ANA_LV.SQL > 03_04_ANA_LV.LOG 

<=CADIM: ORA3-4.SQL > 03_05_ORA3-
4.LOG 

<=AXA SP 1: PST10P2TOP3.SQL > 
03_06_PST10P2TOP3.LOG 

<=AXA SP 1: ORA403-404.SQL > 
03_07_ORA403-404.LOG 

<=AXA SP 1: AXASP1_TO_SP2.SQL > 
03_08_AXASP1_TO_SP2.LOG 

<=AXA SP 3: DTV405-406.SQL > 
03_10_DTV405-406.LOG 

<=AXA SP 3: UPD_T_SELECTION.SQL > 
03_11_UPD_T_SELECTION.LOG 

<=e6 LA: DTV406-407.SQL > 
03_12_DTV406-407.LOG 

<=e6 GA: DTV407-430.SQL > 
03_13_DTV407-430.LOG 

<= e6.0.1: DTV430-431.SQL > 
03_14_DTV430-431.LOG 

CUSTOMER_DATABASE_TASKS.SQL > 
03_17_CUSTOMER_DATABASE_TASKS.L
OG 

upg04_dtv_get.cmd Gets XML files for the step “DTV-
Upgrade” in shell mode. 

-- 

upg05_dtv_update.c
md 

Proceeds XML files for the step 
“DTV-Upgrade” in shell mode. 

-- 

upg06_sync_get.cm
d 

Runs the step “Analyze repository” 
in shell mode. 

 

upg07_sync_update.
cmd 

Runs the step “Synchronize 
repository” in shell mode. Called 
SQL scripts are saved in the file 
07_sync_update.log 

<= PLM5.x: before_sync.sql > 
07_01_before_sync.log 

upg08_postaction.c
md 

Runs some SQL scripts, which are 
necessary after performing 
“Synchronize repository” upgrade 
step. Called SQL scripts are saved in 
the file 08_postaction.log 

cre_rep_edb.sql > 08_01_cre_rep_edb.log 
cleanup.sql > 08_02_cleanup.log 

db_defaults.sql > 08_03_db_defaults.log 
artmeh_1.sql > 08_04_artmeh_1.sql 
update_defartmehr.sql  > 
08_05_update_defartmehr.log 

36 Upgrade Manual 



Chapter 5 Appendix 

Shell script Description Called SQL scripts 

artmeh_2.sql > 08_06_artmeh_2.sql  

special602.sql  > 08_07_special602.log 

get_compile_all.sql > compile_all.sql 

compile_all.sql > 08_08_compile_all.log 

invalid_objects.sql > 
08_09_invalid_objects.log 

upg09_common_ge
t.cmd 

Generates XML files for several 
upgrade steps, one for each 
common PLM module. Called SQL 
scripts are saved in the file 
09_common_get.log 

del_and_save_lvmodel.sql >  
09_01_del_and_save_lvmodel.log 

upg10_common_up
date.cmd 

Proceeds common PLM modules 
XML files. Called SQL scripts are 
saved in the file 
10_common_update.log 

compare_lgv.sql > 10_01_compare_lgv.log 

<=PLM5.x: edb_explorer.sql > 
10_02_edb_explorer.log 

 

upg11_cla.cmd Upgrades PLM Classification. -- 

upg13_prod1_takeo
ver.cmd 

Starts a user interface to proceed 
with “Takeover production data”. 
Scripts upg14_prod2_rep_update 
and upg15_prod3_postaction have 
to be executed after that. 

-- 

upg14_prod2_rep_u
pdate.cmd 

Synchronizes repository (this script 
includes all necessary pre-action 
and post-action calls). 

SQL Files of upg07_sync_update.cmd and 
upg08_postaction.cmd are called again 
 
get_numvalue.sql > 
14_01_get_numvalue.log 
set_numvalue.sql > 14_02_set_numvalue.log 

cre_rep_edb.sql  > 14_03_cre_rep_edb.log 

upg_env.cmd Common upgrade settings, like 
Java, JRE, Path, etc. 

-- 

xml2drop.cmd Generates ora/ ref_data_tab.par and 
ora/ref_data_tab_drop.sql files for 
manual import/export of 
production tables. First, you have to 
configure which tables are relevant 
for the takeover step. 

-- 

xml2html.cmd Converts generated XML files to 
HTML format for a module. 
Example: “xml2html.cmd dtv” Or 
“xml2html.cmd all” 

Possible module names (’all’ for all 
modules): 
 
dtv edb brw dode lgv wfl chg gdm rmt gtm 
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Appendix B: Configuration Files in /conf/ 
 ApplicationParameter.xml - Global application configuration file 

 brwDD.xml - Configuration file for upgrade module BRW (Explorer) 

 chgDD.xml - Configuration file for upgrade module CHG (Change Management) 

 wflDD.xml  - Configuration file for upgrade module WFL (Workflow) 

 dodeDD.xml - Configuration file for upgrade module DODE (Print Studio) 

 dtvDD.xml - Configuration file for upgrade module DTV (DataView Repository) 

 edbDD.xml - Configuration file for upgrade module EDB (Agile PLM configuration) 

 gdmDD.xml - Configuration file for upgrade module GDM (Office integration) 

 gtmDD.xml - Configuration file for upgrade module GTM (Classification) 

 lgvDD.xml - Configuration file for upgrade module LGV (LogiView) 

 rmtDD.xml - Configuration file for upgrade module RMT (Requirement 
Management) 

 special.xml - Configuration file for the step “Synchronize Repository” 

 specialreplace.xml - A sample configuration file for special replace cases 

 ref_tables.xml - Configuration file for the upgrade step “Takeover production data” 

 wfl_ctl.xml - Configuration file for Workflow mapping 

 cla_ctl.xml - Configuration file for Classification Upgrade (PLM5.x to Agile e6) 

 cla_post_ctl.xml - Configuration file for Classification Upgrade (PLM5.x to Agile e6) 

 insert.xsl, delete.xsl, update.xsl, upgrade.xsl - XSL-stylesheet for converting XML 
control files to HTML, used by xml2html.cmd script 

 ref_data_tab_drop.xsl - XSL-stylesheet for generating SQL script, which drops 
production data tables in the customer dump. This stylesheet is used by 
xml2drop.cmd 

 ref_data_tab_par.xsl - XSL-stylesheet for generating table list clause for oracle EXP 
command, which can be used alternatively to transfer production data tables from 
production database. This stylesheet is used by xml2drop.cmd 

 cla_stl.xsl - XSL-stylesheet for configuration file for classification upgrade (Axalant 
2000 to PLM5.x), which generates a HTML output of performed mapping operations 

 dtv_dd.dtd - Document type definition file for module control files 

Appendix C: Contents of the Folder “upgrade/conf/template” 
 ApplicationParameterORACLE.xml - Upgrade Tool settings file with standard values 

for an ORACLE database. Copy this file to upgrade/conf to reset the application 
settings. 

 ApplicationParameterMSSQL.xml - Upgrade Tool settings file with standard values 
for a Microsoft SQL Server database. Copy this file to upgrade/conf to reset the 
application settings. 

 cla_ctl_with_multi_lang.xml - Example for the classification control file (with multi-
lingual definition of the attributes). 
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 cla_ctl_with_multi_lang_repl.xml - Example for the classification control file (with 
multi-lingual definition of the attributes and additional fields for database 
replication). 

 cla_ctl_with_repl.xml - Example for the classification control file (with additional 
fields for database replication). 

 ref_tables.xml – This configuration file is used during the takeover phase for read only 
reasons. Based on settings in this file, a ref_table.xml file is created in the CONF 
directory during the “Create ref. File” step. 

 special_move.xml - Examples for the special case with table field moving. 

 special_rename.xml - Examples for the special case with table field renaming. 

 Special.xml - Default template. 

 specialreplace.xml - Examples for special replace cases. 

Appendix D: SQL Scripts 
Here is a short description of SQL scripts delivered with the Agile Upgrade Tool. All script 
executions create a log file in the log/ directory which are named like the script itself with a prefix 
like 08. 

SQL Script Description 

mssql/sql/after_restore.sql This script is used by chown_mssql.cmd to setup the user/schema and 
default options within a just restored mssql database. 

ana_lv.sql Analyzes LogiView content in the customer dump. Please control the log 
file of this script as described in the manual. 

artmeh_1.sql Conversion of BVB_ARTMEH* tables, for PLM version <= Eigner PLM 
5.x (Part 1). 

artmeh_2.sql Conversion of BVB_ARTMEH* tables, for PLM version <= Eigner PLM 
5.x (Part 2). 

axasp1_to_sp2.sql Upgrade axalant sp1 to axalant sp2. 

before_sync.sql This script has to be executed before running the step “Synchronize 
Repository”. It is done by default with the standard upgrade configuration. 
It prepares the table T_STA_LUT and drops triggers, because otherwise it 
is impossible to insert rows in the involved tables. 

cleanup.sql Ccleans up some dump content and is executed automatically after the 
step “Synchronize Repository”. 

cleanup_c_id_null.sql Cleans up some inconsistencies in the customer dump (like rows with 
negative C_ID values). It must be executed before DTV-upgrade. 

Compare_lgv.sql Compares LogiView procedures in reference dump / customer dump. It is 
executed after the LogiView upgrade. 

customer_database_tasks.sql Executes some cleanup statements to get rid of common dump 
inconsistencies. 
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SQL Script Description 

cre_plm_tbs.sql Creates missing Oracle table spaces. 

cre_plm_usr.sql Creates a database user. This script needs 2 parameters: username and 
password. 

cre_rep_edb.sql Creates all schema objects (tables, views, indexes, packages, triggers, 
sequences, etc.) and inserts number server rows, most of them already 
exist, so a lot of errors will be logged after executing this script. 

db_defaults.sql Overwrites default constraints on the database level, since they are 
different to DataView default definitions. It is executed automatically after 
the step “Synchronize_repository”. 

del_and_save_lvmodel.sql Deletes standard LogiView content and saves customized models with a 
prefix “SAVE-“. 

del_dtv.sql Truncates all DataView internal entries in DTV-tables. 

mssql/sql/ dropall.sql This script can be used to drop all objects within an existing mssql 
database. 

dtv405-406.sql Pre-action script has to be executed before DTV-upgrade for customer 
dump version <= axalant SP3. 

dtv406-407.sql Pre-action script has to be executed before DTV-upgrade for customer 
dump version <= Agile e6.0 LA. 

dtv407-430.sql Pre-action script has to be executed before DTV-upgrade for customer 
dump version <= Agile e6.0 GA. 

Dtv430-431.sql Pre-action script has to be executed before DTV-upgrade for customer 
dump version <= Agile e6.0.1. 

Dtv432-433.sql Pre-action script has to be executed before DTV-upgrade for customer 
dump version <= Agile e6.0.3. 

edb_explorer.sql Converts DTV explorer to Agile e6 EDB-explorer. This step is executed 
once after common modules upgrade. 

getoradrop.sql Get script “dropall.sql” which cleans up a complete database schema. 

get_compile_all.sql Generates a script to recompile all db objects. 

get_numvalue.sql This script is executed in the production database and generates a file 
named “ set_numvalue.sql ” after takeover step. This file updates number 
server values in the customer database. 

get_rebuildidx.sql Generates a file named “ rebuildidx.sql ” to rebuild all indexes in a right 
table pace of a schema. It has 5 parameters for table spaces: 
EDB EDB_IDX EDB_LOB EDB_TMP EDB_TMPIDX 

grant_select_t_constraint.sql Grants a selection on table T_CONSTRAINT for the customer database. 
This permission is needed for constraint conversions. 
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SQL Script Description 

Invalid_objects.sql Lists all objects still invalid in the dump. 

levind_in_stalut.sql This script is called automatically after “Synchronize Repository” and 
converts records in the table T_STA_LUT. It is needed only for upgrades 
from <= Eigner PLM to >= Agile e6. 

ora3-4.sql This pre-action-script is called automatically if the customer dump is a 
CADIM dump. 

ora403-404.sql Pre-action script has to be executed before DTV-upgrade for customer 
dump version <= axalant SP1. 

Pst10P2ToP3.sql Pre-action script has to be executed before DTV-upgrade for customer 
dump version <= axalant SP1. 

mssql/sql/ 
show_default_constraints.sql 

This script can be used to examine default values within an mssql 
database. 

special602.sql Special data modifications for upgrade to 6.0.2 

trunc_lvtabs.sql Truncates all LogiView tables. This script is executed on reference dumps 
only! 

update_customers_UIC.sql This script has to be executed on the customer dump before proceeding 
with the upgrade. 

upd_t_selection.sql This script is a workaround for incompatible changes for table 
T_SELECTION in Eigner PLM5.0 This script is already executed on all 
reference dumps delivered with Agile Upgrade Tool. It will automatically 
executed IDs that are necessary in the step “preaction-scripts”. 

update_defartmehr.sql Fills DEFARTMEHR.BVB_ARTIKEL field during the CLEANUP_BVB 
phase of the step “Postaction”. 

mssql/sql/user_indexes.sql Creates a USER_INDEXES view (ORACLE-like) in an mssql database. 
This script is executed during the pre-action phase of an upgrade. 

upg_org_ref_default.sql A sample update script for existing STEP_NO_REF and STEP_ORG_REF 
values. 

Appendix E: Directories 

Directory Description 

cmd Windows 2000 shell scripts of the Upgrade Tool. 

conf Configuration xml files. 

conf\template Some templates of xml configuration files. The Upgrade Tool does not use these files. 
The only exception is the file ref_tables.xml. It will be read by the tool to recreate 
/conf/ref_tables.xml. 

data This directory contains several subdirectories, each for a module – like BRW, EDB, etc. 
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For each module delete, insert, and update xml files are created. After performing of 
these operations on the customer database, error xml file is written. Additionally, html 
files generated for a module are saved here. A file customizing.log in this directory 
contains conflicts caused by customization of the original dump. 

data\dtv DataView upgrade files as described above are stored here. Please read carefully the file 
customizing.log because it contains user-exit conflicts. 

data\sync Log files of the synchronize repository upgrade step are stored in this directory. 

data\cla Log files of the classification upgrade step are stored in this directory. 

doc Upgrade Tool documentation. 

dumps Database dumps can be stored here. Dumps, which are imported / exported by shell 
scripts imp_dmp.cmd and exp_dmp.cmd have to be stored in this directory. 

lib Upgrade Tool java executables. 

log Log files of all sql scripts and common application log files. 

mssql\sql MS SQL server SQL-scripts. 

ora\sql Oracle SQL-scripts. 

scripts Unix / Linux shell scripts of the Upgrade Tool. 

Appendix F: Migration Rules 
Standard rules are available for insert, update, and delete and these rules are verified during the 
comparison of the table contents. They can be overwritten by special definitions. 

Standard Rules for Delete 
Data records deleted in the standard are also deleted in the customer dump.  

Customer-specific dump Source master Target master Action 

+ + - Delete 

Standard Rules for Update 
Data records existing in source master dump that were deleted in the customer dump are not re-
created. Existing data records are updated. The standard changes overwrite the customer changes. 
Special rules apply on field level to protect customer-specific changes. 

Customer-specific dump Source master Target master Action 

+ + + Update 
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Standard Rules for Insert 
Data records not existing in source master dump or in the customer dump are added.  

Customer-specific dump Source master Target master Action 

- - + Insert 

Special Rules 
Customer changes that will not be overwritten by standard changes are: 

 Field defaults and check strings. 

 Customizing hints for fields containing userexits. 

 Special handling for mask components. 

 Replacements of strings (-> specialreplace.xml). 
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